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1. Introduction 
This lab will introduce you to QGIS. QGIS is an open-source desktop GIS package. It runs on 

Windows, Macs, and Linux. You will begin by installing QGIS and will then learn the basic 

layout and tools. In task 4 you will learn how to bring the data you have collected into QGIS. 

2. Objective: Understand the Basic Layout and Functionality of 

QGIS Desktop 
In this lab exercise, you will explore QGIS Desktop. First, you will learn how to install it on each 

operating system. You will then learn the fundamentals of working with map layers, how to style 

data, and how to bring field data into QGIS.  

 Task 1 – Install QGIS 

 Task 2 – A Tour of QGIS—Part 1 

 Task 3 – A Tour of QGIS—Part 2 

 Task 4 – Add Field Data 

3. How Best To Use Video Walkthrough With This Lab 
To aid in your completion of this lab, some lab tasks have an associated video that demonstrates 

how to complete the task. The intent of these videos is to help you move forward if you become 

stuck on a step in a task, or if you wish to see every step required to complete the tasks. 

We recommend that you do not watch the videos before you attempt the tasks. The reasoning for 

this is that while you are learning the software and searching for buttons, menus, and other 

features, you will better remember where these items are and, perhaps, discover other features 

along the way if you discover them on your own. With that being said, please use the videos in 

the way that will best facilitate your learning and successful completion of this lab. 

4. Lab Tasks 

Task 1. Install QGIS 
QGIS can be quickly and easily installed on Windows, Macs, and Linux from installers found on 

the QGIS Download page. 

Detailed instructions organized by operating system are provided below. Install QGIS on your 

platform.  

Installing QGIS on Windows 

For Windows, there are two installation options: 

 QGIS Standalone Installer: The standalone installer installs the binary version of QGIS 

and the Geographic Resource Analysis Support System (GRASS) using a standard 

Windows installation tool. You should choose this option if you want an easy installation 

experience of QGIS. 

http://qgis.org/en/site/forusers/download.html
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 OSGeo4W Network Installer: This provides you with the opportunity to download 

either the binary or source code version of QGIS, as well as experimental releases of 

QGIS. Additionally, the OSGeo4W installer allows you to install other open source tools 

and their dependencies. 

Installing QGIS on Mac OSX 

To install QGIS on Mac OSX, the Geospatial Data Abstraction Library (GDAL) framework 

and Matplotlib Python module must be installed first, followed by the QGIS installation. The 

installation files for GDAL, Matplotlib, and QGIS are available on the KyngChaos Wiki page. 

Installing QGIS on Ubuntu Linux  

There are two options when installing QGIS on Ubuntu: installing QGIS only or installing QGIS 

as well as other various FOSSGIS packages. Either of these methods requires the use of the 

command line, sudo rights, and the apt-get package manager.  

Installing QGIS Only 

Depending on whether you want to install a stable release or an experimental release, you will 

need to add the appropriate repository to /etc/apt/sources.list file. 

With sudo access, edit /etc/apt/sources.list and add the following line to install the current 

stable release’s or current release’s source code, respectively: 

Deb http://qgis.org/debian trusty main 

deb-src http://qgis.org.debian trusty main 

Depending on the release version of Ubuntu you are using, you will need to specify the release 

name of trusty, saucy, or precise. For the latest list of QGIS releases for Ubuntu versions, visit 

the QGIS Download page. 

With the appropriate repository added, you can proceed with the QGIS installation by running 

the following commands: 

sudo apt-get update 

sudo apt-get install qgis python-qgis 

To install the GRASS plugin (recommended), install the optional package by running this 

command: 

sudo apt-get install qgis-plugin-grass 

Installing QGIS and Other FOSSGIS Packages 

The ubuntugis project installs QGIS and other FOSSGIS packages, such as GRASS on Ubuntu. 

To install the ubuntugis package, remove the http://qgis.org/debian lines from 

/etc/apt/sources.list file, then run the following commands: 

sudo apt-get install python-software-properties 

sudo add-apt-repository ppa:ubuntugis/ubuntugis-unstable 

sudo apt-get update 

sudo apt-get install qgis python-qgis qgis-plugin-grass 

http://www.kyngchaos.com/software/qgis
http://qgis.org/en/site/forusers/download.html


Community Health Maps Lab Series: Lab 2—Bringing Field Data Into QGIS 

11/23/2015  Page 3 of 28 

QGIS is also available for Android. We have not provided detailed installation instructions 

because it is in alpha testing at the moment. However, there are plans to have a normalized 

installation process in a future release. More information can be found on the QGIS for 

Android page.  

The download is on the QGIS Android Downloads page.  

A related app has recently been announced named QField for QGIS™. For a short time it 

was named QGIS Mobile. It is described as a field data capture and management app 

compatible with QGIS. As of this writing it is in invite-only alpha testing. It is eventually 

expected to be available in the Android Play Store. More information on this app can be 

found on the OpenGIS tech blog.  

Task 2. A Tour of QGIS—Part 1 
Watch a Task 2 Video Walkthrough on YouTube. 

Now that you have installed QGIS you will learn about the basic layout, how to work with 

layers, how to work with zooming and panning tools, and how to add basemaps. 

QGIS is composed of two programs: QGIS Desktop and QGIS Browser. QGIS Desktop is used 

for managing, displaying, analyzing, and styling data. QGIS Browser is used to manage and 

preview data. In this task you will focus on QGIS Desktop. 

Opening a Map in QGIS Desktop 

1) Open QGIS Desktop. 

2) Click on the Project menu and choose Open 

3) Navigate to the Lab 2/Data folder and open the Hawaii_map.qgs file. 

 

4) A map of Hawaii will open. 

http://hub.qgis.org/projects/android-qgis
http://hub.qgis.org/projects/android-qgis
http://qgis.org/downloads/android/
http://www.opengis.ch/tech-blog/
https://www.youtube.com/watch?v=DpOa1ddhNGA
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5) The QGIS Desktop interface is divided into four main areas: menu bar, toolbars, 

panels, and the map display. The following screenshot shows QGIS Desktop with all 

four interface types displayed. 

 

 

 

 

 

6) The Map Display takes up most of the screen space.  

7) The map shown in the Map Display is composed of layers of spatial information. The 

following individual map layers are displayed in the Layers Panel: 

a) HA_cities 

b) Hospitals 

c) Main Roads 

d) HA_rivers 

e) County boundaries  

f) native_hawaiian_homelands 

8) The Menu bar and Toolbars provide access to additional QGIS functionality.  

9) The QGIS project file stores the following types of information: 

Which data layers are in the map 

Where the data layers are stored on your computer 

How those layers are styled 

The extent of the map 

Using Navigation Controls 

Now you will learn how to pan and zoom around the map with the Map Navigation toolbar.  



Community Health Maps Lab Series: Lab 2—Bringing Field Data Into QGIS 

11/23/2015  Page 5 of 28 

1) One of the main toolbars is the Map Navigation toolbar shown below. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2) From left to right, the tools are:  

Touch Zoom and Pan—This can be used with a touchscreen. 

Pan Map—Click and hold the left mouse button to slide the map while 

maintaining the same scale. 

Pan Map to Selection—Pan to a selected feature. 

Zoom In—Zoom in by dragging the mouse or clicking. 

Zoom Out—Zoom out by dragging the mouse or clicking. 

Zoom to Native Pixel Resolution 

Zoom to Full Extents—Zoom to the full extent of all layers. 

Zoom to Selection—Zoom to the extent of the selected features. 

Zoom to Layer—Zoom to the extent of the active layer. 

Zoom Last—Zoom to the previous extent. 

Zoom Next—Zoom to the next extent. 

Refresh—Redraw the map. 

3) Click on the  button, and with your left mouse button drag a box around the island 

of Oahu. (Hold the mouse button down until you create the rectangle around Oahu and 

then let go.) 
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4) The map will zoom into Oahu.  

 

 

5) You can use the  tool to slide the map while staying at the same scale. This is a good 

way to center the map. Make sure Oahu is centered in your Map Display. 

6) Now you will set a bookmark for this location. Bookmarks let you store geospatial map 

extents. Click the View menu and choose New Bookmark. The Geospatial Bookmarks 

window will open. Name your bookmark Oahu and click Close. 

7) Now you will always be able to get back to this location by clicking View | Show 

Bookmarks, selecting the Bookmark and clicking Zoom to. This is useful if there is a 

particular part of the map you want to be able to get to quickly or for storing the final 

map extent for a map.  
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8) Click the  button until you are back at the original map extent. This button was 

activated as soon as you zoomed into Oahu. Along with the  button you can go 

forward and backward amongst the map extents you’ve viewed.  

9) Back at the original extent, click the View menu | Show Bookmarks. Select the Oahu 

bookmark by clicking on it and then click on Zoom to. Close the Geospatial 

Bookmarks window when finished. 

10) Another useful zoom tool is the  button. This will zoom you out to the full extent of 

all the data layers in your map. Click it now and you will zoom out to the original extent. 

 

Layer Management 

In this next section you will learn how to work with the layers in the Layers Panel.  

1) Use your Oahu bookmark to zoom to Oahu. 

2) Double click on the County Boundaries layer to open the Layer Properties window. 

(You can also right click on the County Boundaries layer and choose Properties from 

the context menu.) 

3) Click on the General tab. 

4) Here you can see that the Layer source is Lab2/Data/Hawaii/county10.shp but the 

Layer name is County Boundaries. 

5) County10.shp is the source file for this layer. It is a file format known as a shapefile.  

6) When a layer is added to QGIS Desktop, it will be given the name of the shapefile by 

default.  

7) Here someone has changed the Layer name to County Boundaries. This is preferable 

because the Layer name is what will appear on a map legend. Layer names should be 

changed to something understandable by the intended map reader.  

8) Close the Layer Properties window. 

9) Open the Layer Properties window for the native_hawaiian_homelands layer. 
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10) Change the Layer name to Native Hawaiian Homelands and close the Layer 

Properties window. Notice that the Layer Name has changed in the Layers Panel. 

11) Change the following names in the same fashion: 

a) HA_rivers to Rivers 

b) HA_cities to Cities 

12) Notice that the Native Hawaiian Homelands have a peachy/orange colored patch next to 

the Layer name in the Layers panel. This patch indicates how the data are styled on the 

map. However, no orange patches are visible on the map.  

The data layers in the Layers panel are drawn in the order they appear in. So the layer 

that is on the top of the list in the Layers panel will be drawn on top of the other layers 

in the Map view. 

13) Click on the Native Hawaiian Homelands layer and drag it above the County 

Boundaries. The Native Hawaiian Homelands data should now be visible. 

 

14) Notice that layers have a checkbox to their left. The Hospitals layer is unchecked. This 

means it is turned off and not visible. Click the checkbox to turn this layer on. You will 

now see the Hospital locations on the map. Layers can be toggled on and off in this way.  
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 

 

 

 

 

 

15) Click the  button to save your QGIS map document. The next time you open this, it 

will look exactly as it does now. 

16) If you are moving on to Task 3, click the  button to start a new QGIS Project.  

17) The File toolbar contains tools for managing QGIS projects.  

18) From left to right the buttons are: 

New—Open new project. 

Open—Open existing QGIS project file. 

Save—Save QGIS project. 

Save as… 

New Print Composer—Open new Print Composer. 

Composer Manager—Open Print Composer Manager. 

Task 3. A Tour of QGIS—Part 2 
Watch a Task 3 Video Walkthrough on YouTube. 

Now that you have begun to familiarize yourself with QGIS Desktop, and the data for Hawaii, 

you will learn how to build a map from scratch in QGIS Desktop. You will rebuild the Hawaii 

map. 

https://www.youtube.com/watch?v=V_9LD6I1CT8
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Adding Data to an Empty QGIS Project 

1) Either open a new QGIS Desktop project as you did in Step 1 of Task 2, or if you are 

moving on from Task 2 click the  button to start a new QGIS Project. A blank QGIS 

Desktop window will open. 

 

 

QGIS has Add Data buttons for each major geospatial data model (vector and raster). 

2) Click the  button. It is located on the toolbar along the left hand side of the Layers 

panel. 

3) Alternatively, you can click Layer | Add Layer | Add Vector Layer. 

4) This opens the Add vector layer window. Let’s add one of the ESRI shapefiles, which 

is a file-based dataset. 

5) Keep the Source type “File” which is the default. Then click the Browse button. 
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6) The Open an OGR Supported Vector Layer window opens. (NOTE: OGR is a 

FOSS4G project with the sole purpose to read and write geospatial vector data files.) 

The window defaults to all files. Take a moment to see the available options. QGIS can 

open many different vector file formats! Click the All files dropdown box and change to 

ESRI Shapefiles (shown in figure below). 

 

 

7) Select county10.shp and click Open. 

8) Now back at the Add vector layer window, click Open to add the data to QGIS 

Desktop (see figure below). 
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9) You will now see county10 in the Layers panel and the map features displayed in the 

Map canvas. Vector GIS layers will come in with random colors. You will learn how to 

change layer styling after all the layers have been added. 

Now you will learn another method of adding data to QGIS Desktop. You will use the 

QGIS Desktop Browser panel. 

10) Click View | Panels and make sure Browser is checked. The Browser panel will now 

be displayed. 

Note: Panels can be docked and undocked from the QGIS Desktop window. To undock 

a panel, click and drag the panel’s top title bar (outlined in figure below) and drag it 

away from the sides. When you release your mouse button, the panel will be floating 

freely. 
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To dock a floating panel, click and drag the title bar, and drag the panel to the left or 

right side of QGIS Desktop until a rectangle appears underneath the panel. Release the 

mouse button to dock the panel (docking action shown in figure below). 

 

 

11) Drag the title bar of the Browser panel and drop it right on the Layers panel (without 

the rectangle appearing).  It will then become a tab on the Layers panel. With this 

arrangement, it is always accessible without taking up additional screen space. 

12) Note that there is a Favourites item. You can identify folders or locations as being 

Favourites in order for them to appear here. 

Data is often stored deep inside a series of folders. It is often tedious and time 

consuming to navigate deep inside the folders to gain access to the data. Favourites 

provide a way to create a shortcut directly to any folder so that you have one-click 

access to any folder. Let’s create a favorite to our lab folder for practice. 
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13) Navigate to the lab data folder in the Browser panel. Right click on the Data folder and 

choose Add as a Favourite (see figure below). Note: Currently this functionality is 

reserved only for the Browser panel in QGIS Desktop. However, once it is set it will 

show up as a Favourite in QGIS Browser as well. 

 

 

 

 

 

 

 

 

14) Now expand Favourites near the top of the file tree in the Browser panel by clicking 

the plus sign to the left. You will see the Lab 2 data folder listed. Setting the folder as a 

Favourite allows you to quickly navigate to your working folder.  

15) You will see 6 shapefiles in the lab data folder: 

county10.shp 

HA_cities.shp 

HA_hospitals.shp 

HA_rivers.shp 

native_hawaiian_homelands.shp 

SDOT_StateRoutes.shp 

16) You can select them all by holding down the Ctrl key on your keyboard while left 

clicking on each shapefile. Select the five shapefiles you haven’t added (HA_cities.shp, 

HA_hospitals.shp, HA_rivers.shp, native_hawaiian_homelands.shp, and 

SDOT_StateRoutes.shp). 
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17) Drag the five selected shapefiles onto the map canvas from the Browser panel. This is 

another way of adding geospatial data to QGIS Desktop. 

18) Click the Layers tab to display the Layers panel. QGIS Desktop should now look like 

figure below. The random colors that QGIS assigns to the layers may be different from 

the figure below but that is fine. 

 

 

Reordering and Renaming the Layers 

Now that the data have been added, you will reorder and rename the layers as you learned in 

Task 2. 

1) Now rename the layers as you did in the Layer Management section of Task 2.  
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2) Now reorder the layers as you did in Step 13 of Task 2 | Layer Management. 

 

 

Styling the Data Layers 

Now you will learn how to style these layers. 

1) Double-click on the Main Roads layer to open the Layer Properties window. 

2) Click on the Style tab. 

3) In the Symbol layers box, click on Simple line. 

4) Find the Symbol layer type box on the top right corner of the Layer Properties window. 

This allows you to change both the color and width for this line layer. Click on the 

colored box to the right of Color to open the Color picker window. 

This window has many options for choosing a color. You can use the tabs across the top 

to open a color ramp, color wheel, color swatches, or a color picker. You can also use 

the HSV and RGB sliders on the right side to define a specific color. 
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5) Click the Color swatches tab. 

 

 

6) Choose black from Standard Colors and click OK. 

7) Back at the Layer Properties window click OK again and see the new style applied to 

the roads layer.  

8) Using the same technique, change the rivers layer to blue. 

9) Double click on the County Boundaries layer to open the Layer Properties | Style tab. 

10) In the Symbol layers box click on Simple fill. 

11) This is a polygon layer, so you have the option to change both the Fill and Border 

colors and their respective styles.  

12) Click the fill color patch to open the color picker window. 

13) Here you will use the Red, Blue, Green (RGB) color slider to define the color. Set the 

RGB values to R: 215, G: 194, B: 158.  
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14) Click OK and then OK on the Layer Properties window to set the style. Counties 

should now be a beige color. 

15) Using the same technique change the fill for Native Hawaiian Homelands to the RGB 

color: R: 255, G: 167, B: 127. 

16) Change the Border color for Native Hawaiian Homelands to red from the Color 

swatches tab. 

17) Now you will style the two point layers: Cities and Hospitals. 

18) Open the Layer Properties | Style tab for Cities. 

19) Click on Simple marker. 

20) From the available simple markers at the bottom of the Symbol layer type choose the 

square.  

21) Change the Fill to white and the Size to 2, and click OK to accept these changes and 

close the Layer Properties window. 

 

 

22) Open the Layer Properties | Style tab for Hospitals. 

23) Click on Simple marker. 

24) Click the dropdown menu for Symbol layer type. For point data there are several 

different sets of marker symbols. Choose SVG Marker.  
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25) A large list of SVG groups organized by folders will appear in the symbol window. 

Click on the emergency folder. 

 

 

26) Select the cross symbol. 

27) You can change the colors and sizes of these SVG symbols. Change the Fill color to a 

dark blue. Leave the Size at 7. 

28) Zoom in to Oahu. Your map should now resemble the figure below.  
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Adding Labels 

Finally, you will label the Cities. You will use one of the attribute columns to label the layers.  

1) Right click on Cities and choose Open Attribute table from the context menu. 

 

2) Each table row represents data for one of the city points. You can see that there are 

26 cities in the layer.  

3) Each column contains things you know about each city point. Notice that there is a 

column called Name containing city names. You will use this to label the Cities. Close 

the table by clicking the X in the upper right hand corner.  

4) Open the Layer Properties | Labels tab for the Cities layer.  

5) Click the Label this layer with checkbox and from the associated dropdown menu 

choose NAME as the attribute to use.  

6) Along the left side are several labeling tabs that allow you to specify the appearance and 

behavior of the labels: Text, Formatting, Buffer, Background, Shadow, Placement, 

and Rendering. Click on the Buffer item. 

7) Click the checkbox next to Draw text buffer. This will place a halo around the label, 

making it easier to read against a busy background. Keep the default setting of Size = 1 

and Color = white. Click OK on the Layer Properties window. 
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8) Your final map will include city labels. 
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Task 4. Add Field Data 
Watch a Task 4 Video Walkthrough on YouTube. 

Now that you are familiar with the basics of QGIS Desktop, you will add some data collected 

with iForm to QGIS. This data represents locations of Skilled Nursing staff collected by some 

community mappers in Hawaii. 

ODK Collect provides the data as a CSV file and iForm as an Excel spreadsheet. In this task, you 

will be working with an Excel spreadsheet collected with iForm. 

Converting a Spreadsheet to a Comma Delimited Text File 

1) The Excel spreadsheet data provided by iForm first needs to be converted to a CSV file.  

2) QGIS provides several tools for adding different types of data to your map.  

3) The Add Vector Layer button can be used to add shapefiles as you saw in Task 3. It 

can also be used to add an Excel spreadsheet. Click the Add Vector Layer button. 

 

 

 

4) Click Browse on the Add Vector Layer window to open the Open an OGR 

Supported Vector Layer window. Set the filter in the lower right corner to All files. 

Navigate to the course data folder and select SkilledNursing.xls.  

5) Click Open to add the data to QGIS Desktop. The spreadsheet will be added to the 

Layers panel with a table icon next to it. 

https://www.youtube.com/watch?v=DkXZLK5lMP8
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6) To convert this to a CSV file, right click on it and choose Save as from the context 

menu. 

7) In the Save vector layer as dialog: 

a) Choose Comma Separated Values (CSV) as the Format 

b) Click Browse, and navigate to your project folder and name the new copy. 

c) Click OK. 

d) The CSV version of the data table will be added to QGIS. 

 

 

8) You can preview the CSV file to familiarize yourself with the data structure. To open it 

within QGIS, right click on the SkilledNursing layer, and choose Open Attribute Table 

from the context menu. Identify the columns with the latitude and longitude. The 

structure of the table is shown below. 
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Mapping Field Data With QGIS 

1) You will now use the Add Delimited Text Layer option to map these data. 

 

 

2) Populate the Create a Layer from a Delimited Text File dialog as below.  

a) For File Name browse to your CSV file. 

b) Provide an output Layer name. 

c) Choose CSV as the delimiter. 

d) The window below will provide a preview of the parsed file. By default QGIS 

isn’t reading the file correctly. 

e) Check First record has field names and set the Number of header lines to 

discard at 2 so that the field names display correctly. 

f) Choose the X and Y fields. Hint: X is longitude and Y is latitude. 

g) Click OK. 

h) The Coordinate Reference System Selector will open asking you to identify the 

coordinate system of the coordinates. In the Filter textbox, type EPSG:4326 to 

find the WGS84 coordinate system of the data. Select this CRS. This is the 

coordinate system used by the GPS system. 
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i) Click OK. 

j) The data will show up as a temporary point layer with all the attributes. 

k) To save it as a permanent shapefile, right click on the layer and choose Save As… 

from the context menu.  
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l) Fill out the Save vector layer as... dialog.  

i. Set the Format to ESRI Shapefile. 

ii. Browse to the lab data folder and name the new shapefile 

SkilledNursing.shp. 

iii. Click OK.  

 

3) The new layer is added to QGIS and you have successfully created a permanent mapped 

layer of your fieldwork! 

4) Turn off the original SkilledNursing layer so that only the new shapefile version is 

enabled. Your map will now resemble the figure below. 
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5) Using what you have learned, style these points and label them with the NAME column. 

6) The following screenshot shows them styled with a large red circle and labeled. The 

cities have been turned off and we have zoomed in to the Honolulu area. 
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5. Conclusion 
In this lab, you learned the basic layout and functionality of QGIS Desktop. You saw how to add 

style and label layers of information. You also learned how to bring data collected from iForm 

into QGIS and map the points. 

6. Challenge Assignment 
Now that you understand the basics of working with QGIS and importing field data, import the 

data you collected in Lab 1. 
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